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This document provides detailed delivery information for all accepted media and files for the iTunes Store,
including music, music video, television, and movies. If further details are required, contact your iTunes
Technical Representative.

Introduction

Quality is important to us at iTunes. We expect to receive the highest-quality assets available. Our product
must meet or exceed the quality of the physical product already out in the marketplace. For example, if 5.1
surround sound or closed captions exist on the physical version of the product, those must be provided. If
the physical product gives the chapters actual names (as opposed to Chapter 1, Chapter 2, and so on), then
our product should have those same chapter titles. If the album is in stereo, stereo audio must be provided.

Changes Made in this Release

Changes MadeDate/Version

Clarified that ALAC in a CAF container is allowed. Added source profile for
pre-cut ringtones. Clarified that film ratings should not appear on poster
art.

February 3, 2010 - Version 4.3

For a complete history of changes, see “Previous Spec Revisions” (page 37).

What’s New in iTunes Store Package Asset Specification 4.3?

Assets: Audio Formats

ALAC audio source can be delivered in a CAF (Core Audio Format) container.

The audio file for pre-cut ringtones must be lossless and be one of these formats: WAV, FLAC, or ALAC. The
minimum length is 5 seconds and the maximum length is 30 seconds.

Assets: Film Poster Art

Poster art for film must not display film ratings.
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Music Audio Source Profile

The iTunes Store accepts audio with a sampling rate of 44.1Khz and 16-bit or 24-bit resolution. Note that the
audio source must be stereo unless it does not exist.

Uncompressed audio formats supported are:

Qualified CODECContainer TypeFormat

WAV (.wav)Pulse-Code Modulation (PCM)

QuickTime http://www.apple.com/quicktime

iTunes http://www.apple.com/itunes

M4A (.m4a)Apple Lossless (ALAC)

iTunes ProducerCAF (.caf)

FLAC http://flac.sourceforge.netFLAC (.flac)Free Lossless Audio Codec (FLAC)

All other audio formats will be rejected.

Important:  All audio must be generated using a CODEC qualified and approved by Apple.

Pre-Cut Ringtone Source Profile

The iTunes Store accepts pre-cut ringtones with a sampling rate of 44.1Khz and 16-bit or 24-bit resolution.
Note that the audio source must be stereo unless it does not exist. The audio file must be lossless and be
one of these formats: WAV, FLAC, ALAC. The minimum length is 5 seconds and the maximum length is 30
seconds.

See the table above for the uncompressed audio formats that are supported. All other audio formats will be
rejected.
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Important:  All audio must be generated using a CODEC qualified and approved by Apple.

Music Cover Art Image Profile

 ■ TIFF with “.tif” extension (32-bit uncompressed), JPEG with “.jpg” extension (quality unconstrained), or
PNG with “.png” extension

 ■ RGB (screen standard)

 ■ Minimum size of 600 x 600 pixels

 ■ Images must be at least 72 dpi

Important:  CMYK (print standard) images will not be accepted.

Music Digital Booklet Profile

 ■ PDF format with “.pdf” extension

 ■ Four-page minimum

 ■ No more than 10 MB in size

 ■ All fonts embedded

 ■ 72 dpi minimum

 ■ 11 in x 8.264 in (28 cm x 21 cm)

 ■ RGB color

 ■ Horizontal presentation

 ■ All images full-bleed as shown in sample pages

Important:  These booklets are expressly designed for the iTunes Store format, and cannot be reproductions
of the liner notes with borders to increase their size.

Content Considerations

 ■ When saving as PDF, make sure the document opens full screen with no negative space surrounding
the document.

 ■ If the digital booklet is many pages, consider using fewer images or optimizing images to achieve lower
overall file size.

 ■ Printer’s marks are not allowed.

 ■ You cannot sell or advertise other products or services. No other promotional sites are allowed.
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 ■ No links to anything outside of the booklet, except to the artist and/or label website(s).

 ■ No time-sensitive information (for example, a promotion or dates for an upcoming tour or concert).
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Music Video Source Profile

NTSC

 ■ MPEG-2 Program Stream Main Profile

 ■ 4:2:0 chroma sampling

 ■ ITU-R BT.601 color space

 ■ 15 Mbps minimum

 ■ Long GOP

 ■ 640 fixed horizontal dimension

 ■ Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ■ Square pixel aspect ratio (1:1)

 ■ Native frame rate of original source: 

 ❏ 29.97 interlaced frames per second video source can be delivered either interlaced or de-interlaced
properly tagged as progressive

 ❏ 24 frames per second must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ❏ Telecine materials will not be accepted

 ❏ For mixed frame rate material please contact your iTunes Technical Representative

 ■ Interlaced content must be tagged non-progressive and field ordering must be defined in the stream.

 ■ Crop inactive pixels and maintain fields. All edges must have active pixels for greater than 90% of the
duration of the video.

PAL

 ■ MPEG-2 Program Stream Main Profile

 ■ 4:2:0 chroma sampling

 ■ ITU-R BT.601 color space

 ■ 15 Mbps minimum
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 ■ Long GOP

 ■ 640 fixed horizontal dimension

 ■ Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ■ Square pixel aspect ratio (1:1)

 ■ Native frame rate of original source:

 ❏ 25 interlaced frames per second sourced from video must be delivered de-interlaced and properly
tagged as progressive 

 ❏ 24 and 25 frames per second sourced from film must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ❏ Telecine or interlaced materials will not be accepted

 ❏ For mixed frame rate material please contact your iTunes Technical Representative

 ■ Crop inactive pixels. All edges must have active pixels for greater than 90% of the duration of the video.

Important:  All video must begin and end with at least one black frame.

Music Video Audio Source Profile

 ■ MPEG-1 layer II stereo

 ■ 384 kpbs

 ■ 48Khz

 ■ Included in the same file as the delivered video

Music Video Audio/Video Container

 ■ Deliver all content in an MPEG-2 Program Stream file container

 ■ The .mpg file extension is expected for all MPEG-2 content

 ■ Audio must be delivered muxed with the video stream

12 Music Video Audio Source Profile
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Note:  Closed-captioning is currently not supported for music videos.

Music Video Screen Capture Image Profile

 ■ Screen capture from delivered video

 ■ TIFF with “.tif” extension (32-bit uncompressed), JPEG with “.jpg” extension (quality unconstrained), or
PNG with “.png” extension

 ■ RGB (screen standard)

 ■ 640 fixed horizontal dimension

 ■ Images must be at least 72 dpi

 ■ Variable size vertical dimension. Must be same aspect ratio as video source, with a maximum size of 480.

 ■ Only the active pixel area may be included.

Important:  CMYK (print standard) images will not be accepted.

Music Video Screen Capture Image Profile 13
2010-02-02   |   © 2010 Apple Inc. All Rights Reserved.

CHAPTER 2

Music Video Content Profiles



14 Music Video Screen Capture Image Profile
2010-02-02   |   © 2010 Apple Inc. All Rights Reserved.

CHAPTER 2

Music Video Content Profiles



HD TV Source Profile

 ■ Apple ProRes 422 (HQ)

 ■ ITU-R BT.709 color space, file tagged correctly as 709

 ■ VBR expected at 88-220 Mbps

 ■ 1920 x 1080 or 1280 x 720 square pixel aspect ratio material*

 ■ 23.976, 24, 25, 29.97, 30 frame rates are supported

 ■ Native frame rate of original source: 

 ❏ 29.97 interlaced frames per second video source can be delivered either interlaced or de-interlaced
properly tagged as progressive

 ❏ 24 frames per second must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ❏ Fields and frames may not be duplicated or eliminated to create a broadcast frame rate (for example,
telecine, NTSC to PAL conversion)

 ❏ For mixed frame rate material please contact your iTunes Technical Representative

 ■ Interlaced content must be correctly tagged as interlaced and field ordering must be defined in the
QuickTime container.

 ■ Content upscaled from SD will be rejected.

* If your mezzanine library is not stored in HD D5 or HDCam-SR, contact your iTunes Technical Representative.

SD TV Source Profile

NTSC

 ■ MPEG-2 Program Stream Main Profile

 ■ 4:2:0 chroma sampling

 ■ ITU-R BT.601 color space

 ■ 15 Mbps minimum
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 ■ Long GOP

 ■ 640 fixed horizontal dimension

 ■ Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ■ Square pixel aspect ratio (1:1)

 ■ Native frame rate of original source:

 ❏ 29.97 interlaced frames per second video source can be delivered either interlaced or de-interlaced
properly tagged as progressive

 ❏ 24 frames per second must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ❏ Fields and frames may not be duplicated or eliminated to create a broadcast frame rate (for example,
telecine, NTSC to PAL conversion)

 ❏ For mixed frame rate material please contact your iTunes Technical Representative

 ■ Interlaced content must be tagged non-progressive and field ordering must be defined in the stream.

 ■ Crop inactive pixels and maintain fields. All edges must have active pixels for greater than 90% of the
duration of the video.

 ■ Content may NOT be delivered letterbox, pillarbox, or windowbox.

PAL

 ■ MPEG-2 Program Stream Main Profile

 ■ 4:2:0 chroma sampling

 ■ ITU-R BT.601 color space

 ■ 15 Mbps minimum

 ■ Long GOP

 ■ 640 fixed horizontal dimension

 ■ Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ■ Square pixel aspect ratio (1:1)

 ■ Native frame rate of original source:

 ❏ 25 interlaced frames per second sourced from video must be delivered de-interlaced and properly
tagged as progressive

 ❏ 24 and 25 frames per second sourced from film must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ❏ Interlaced materials will not be accepted
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 ❏ Fields and frames may not be duplicated or eliminated to create a broadcast frame rate (for example,
telecine, NTSC to PAL conversion)

 ❏ For mixed frame rate material please contact your iTunes Technical Representative

 ■ Crop inactive pixels. All edges must have active pixels for greater than 90% of the duration of the video.

 ■ Content may NOT be delivered letterbox, pillarbox, or windowbox.

Important:  All video must begin and end with at least one black frame.

TV Audio Source Profile

MPEG-2 Program Stream Container

Stereo

 ■ MPEG-1 layer II

 ■ 384 kpbs

 ■ 48Khz

 ■ Included in the same file as the delivered video

QuickTime Container

Surround

 ■ LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ■ Expected channels: L, R, C, LFE, Ls, Rs

Stereo

 ■ LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ■ Expected Dolby Pro Logic channels: Lt, Rt or expected stereo channels: L, R

TV Audio/Video Container

MPEG-2 Program Stream Container

 ■ Deliver all content in an MPEG-2 Program Stream file container

 ■ The “.mpg” file extension is expected for all MPEG-2 content
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 ■ Audio must be delivered muxed with the video stream.

QuickTime Container

 ■ Deliver all content in a QuickTime .mov file container

 ■ The QuickTime “.mov” file extension is expected for all audio and video content.

 ■ Each audio channel must have an assignment. The channel assignments must match one of the options
below. Note that "Lt" and "Rt" are only used for Dolby matrix audio mixdown. If audio doesn't conform,
contact your iTunes Technical Representative.

18 TV Audio/Video Container
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Important:  Refer to “Table 1: Audio Channel Assignment Labels” (page 35) for label descriptions and “How
to Apply Audio Channel Assignments” (page 29) for instructions on applying audio channel assignments.

TV Cover Art Profile

 ■ TIFF with “.tif” extension (32-bit uncompressed), JPEG with “.jpg” extension (quality unconstrained), or
PNG with “.png” extension

 ■ RGB (screen standard)

 ■ 600 x 600 pixels minimum size

 ■ Images must be at least 72 dpi

 ■ 1:1 aspect ratio

Important:  CMYK (print standard) images will not be accepted.

TV Content Considerations

 ■ No network Bugs or logos should be visible during the body of the video.

 ■ No ratings or advisories should be displayed at any time during the video.

 ■ Network cards at the beginning and end of the video are accepted as long as they are visible less than
five (5) seconds.

 ■ Promotional bumpers are NOT accepted. For more details, please contact your iTunes Technical
Representative.

 ■ Previews must contain content suitable for a general audience.

 ■ Previews must not have opening or ending credits.

 ■ A minimum of 1 black frame at the beginning and end of each video is required.
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Film HD Source Profile

 ■ Apple ProRes 422 (HQ)

 ■ VBR expected at ~220 Mbps

 ■ 1920 x 1080 square pixel aspect ratio material

 ■ Native frame rate of original source:

 ❏ 24 or 25 progressive frames per second for film sourced

 ❏ 23.976 progressive frames for inverse telecine sourced from film

 ❏ 29.97 interlaced frames per second for video sourced

 ❏ Telecine materials will not be accepted

 ■ Content may be delivered matted: letterbox, pillarbox, or windowbox.

Important:  All video must begin and end with at least one black frame.

Film SD Source Profile

NTSC

 ■ Apple ProRes 422 (HQ)

 ■ VBR expected at 40-60 Mbps

 ■ 720 x 480 or 720 x 486 encoded pixels; for display at either 853�x 480 for 16:9 content or 640 x 480 for
4:3 content

 ■ All encoded content must include pixel aspect ratio (pasp) that defines content as either 4:3 or 16:9.

 ■ Native frame rate of original source:

 ❏ 24 frames per second must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ 29.97 frames per second video source can be delivered interlaced

 ❏ Telecine materials will not be accepted
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 ■ Content may be delivered matted: letterbox, pillarbox, or windowbox.

PAL

 ■ Apple ProRes 422 (HQ)

 ■ VBR expected at 40-60 Mbps

 ■ 720 x 576 encoded pixels; for display at either 1024 x 576 for 16:9 content or 768 x 576 for 4:3 content

 ■ All encoded content must include pixel aspect ratio (pasp) that defines content as either 4:3 or 16:9.

 ■ Native frame rate of original source:

 ❏ 24 and 25 frames per second sourced from film must be delivered progressive

 ❏ 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ❏ Telecine materials will not be accepted

 ■ Content may be delivered matted: letterbox, pillarbox, or windowbox.

25 fps interlaced PAL films are NOT supported.

Important:  All video must begin and end with at least one black frame.

Film Audio Source Profile

Note that audio source must be delivered in 5.1 Surround and stereo; exceptions may be made to the 5.1
requirement where it doesn’t exist.

Surround

 ■ LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ■ Expected channels: L, R, C, LFE, Ls, Rs

Stereo

 ■ LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ■ Expected Dolby Pro Logic channels: Lt, Rt or expected stereo channels: L, R

Film Audio/Video and Alt-Audio Container

 ■ Deliver all content in a QuickTime .mov file container

 ■ The QuickTime “.mov” file extension is expected for all audio and video content.
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 ■ Each audio channel must have an assignment. The channel assignments must match one of the options
below:

Important:  Refer to “Table 1: Audio Channel Assignment Labels” (page 35) for label descriptions and
“How to Apply Audio Channel Assignments” (page 29) for instructions on applying audio channel
assignments.

Note:  For more information on alternate audio, see the “Assets and Data Files” section in the Film Profile.

Film Closed-Captioning Profile

 ■ In EIA 608 format

 ■ Delivered in the same package with the video it references

 ■ In a Scenarist SCC formatted file, using .scc file extension

Film Closed-Captioning Profile 23
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 ■ SCC files must be 29.97 regardless of frame rate of the movie file

 ■ SCC files should preserve the timecode mode (drop or non-drop) used in your captioning process, not
necessarily the mode represented in the QuickTime movie source.

The timecodes of the captions are relative to the start of the program, and not the QuickTime movie's timecode
track.

Currently, the iTunes Store does not support EIA 708 (ATSC closed captioning) or Teletext.

MacCaption is a tool you can use to create .scc files: http://www.cpcweb.com/products/. (Note that this
product is not endorsed by Apple. Apple cannot and does not provide support for third-party products.)

Note:  The closed caption file must be provided unless it does not exist.

Film Chapter Image Profile

 ■ JPEG with “.jpg” extension (quality unconstrained)

 ■ RGB (screen standard)

 ■ Must be same aspect ratio as video source

 ■ 640 minimum horizontal dimension (larger for HD sourced)

 ■ Variable size vertical dimension (based on aspect ratio of video source)

 ■ Images must be at least 72 dpi

 ■ Only active pixel area may be included

 ■ Chapter images must be cropped (no letterbox, pillarbox, or windowbox)

 ■ Chapter images must contain picture content

 ■ Chapter image files must be unique with different checksums

Important:  CMYK (print standard) images will not be accepted.

Film Poster Art Profile

 ■ TIFF with “.tif” extension (32-bit uncompressed), JPEG with “.jpg” extension (quality unconstrained), or
PNG with “.png” extension

 ■ RGB (screen standard)

 ■ 800 x 1200 pixels minimum size

 ■ Images must be at least 72 dpi

 ■ 2:3 aspect ratio
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 ■ Poster art (one-sheet) from film. Must contain key art and title. Credits block, DVD cover, release date,
website, or promotional tagging may not be included.

 ■ Poster art must not display film ratings.

Important:  CMYK (print standard) images will not be accepted.

Film Content Considerations

 ■ The full movie asset should not contain FBI, MPAA, or release date tagging

 ■ The trailer asset should not contain FBI, MPAA, or release date tagging

 ■ A minimum of 1 black frame at the beginning and end of each video is required

 ■ Trailer should be same aspect ratio as the full asset

 ■ Promotional bumpers, including URLs, are NOT accepted. For more details, please contact your iTunes
Technical Representative.

 ■ Trailers must contain content suitable for a general audience

 ■ Poster art should not contain DVD tagging, credits block, release data tagging, or website tagging
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 ■ All XML must be encoded in UTF-8

 ■ No byte order markers (BOM) may be used

 ■ There should be no null data or empty tags in the XML. If not used, elements should be removed

 ■ The XML must be formatted to use line breaks and indentations.

For further information, please refer to the appropriate media type metadata specification, or consult with
your iTunes Technical Representative.
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How to Apply Audio Channel Assignments

Step 1: Open the Movie Properties window from the Window > Show Movie Properties menu.

Important:  You must use the Pro version of QuickTime.

Standard Movie Properties window:

How to Apply Audio Channel Assignments 29
2010-02-02   |   © 2010 Apple Inc. All Rights Reserved.

APPENDIX A

Audio Channel Assignments



Step 2: Go to the View > Columns menu and choose Channels. You may add additional columns like ID,
Data Rate, and so on.
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Notice the Channels column in the following screenshot indicates the audio tracks are Mono.
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Step 3: Select the sound track to make the audio channel assignment and click the Audio Settings tab.

Step 4: To make the Channel Assignment, choose the appropriate setting from the pop-up menu. Repeat
this process for each audio track.
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In this example all the tracks have been properly assigned for the channel assignments of Option 2 as indicated
in the Audio/Video Container section for “Television Content Profiles” (page 15) and “Film Content
Profiles” (page 21).

Notice the Channels column in the following screenshot no longer indicates the audio tracks are Mono.
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Notice this indicates the assignment.
This should not indicate mono.

Step 5: Save the file.

Step 6: Open the Movie Inspector from the Window > Show Movie Inspector menu to verify assignments
were applied correctly.
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Table 1: Audio Channel Assignment Labels

DescriptionLabel

LeftL

RightR

CenterC

LFE ScreenLFE

Left SurroundLs

Right SurroundRs

Left TotalLt*

Right TotalRt*

* Lt and Rt are supported in the latest version of QuickTime.
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Previous Spec Revisions

The following table lists the previously-released specifications and the revisions:

SummaryDate/Version

Clarified quality standards. Clarified closed captioning.December 18, 2009 - Version 4.2

Clarified audio requirements for music and film.November 10, 2009 - Version 4.1

Added best practices content for Film. Clarified requirements for .SCC
files.

September 11, 2009 - Version 4.0

Clarified image and audio requirements. Clarified frame rate
requirements for TV.

July 1, 2009 - Version 3.3.2

Added support for PNG format images for cover art, poster art, and
video screen captures. PNG images are not currently supported for
chapter thumbnail images.

May 12, 2009 - Version 3.3.1

Added updated PAL support for film. Added closed-captioning to Film
Content Profile. Added 24-bit support for audio. Added best practices
content for TV. Clarified how to send stereo sound for Film and TV.

March 17, 2009 - Version 3.3

Added audio source specification to Music Audio Content Profile, added
HD format to Television Content Profile and Appendix I, which provides
audio channel assignments instructions.

October 1, 2008 - Version 3.2

Complete reformatting of the Guide. Separation of content type profiles.
Addition of Movie HD and SD specification. Addition of image
specifications for TV and Film.

May 8, 2008 - Version 3.1.1

Introduction of Asset Specification Guide.April 2, 2007 - Version 2.3
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